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“ADOBE PHOTOSHOP”

Adobe Photoshop

Adobe Photoshop is a graphics editing program developed and published by Adobe
Systems.

Adobe's 2003 "Creative Suite" rebranding led to Adobe Photoshop 8's renaming to Adobe
Photoshop CS. Thus, Adobe Photoshop CS6 is the 13th major release of Adobe
Photoshop. The CS rebranding also resulted in Adobe offering numerous software
packages containing multiple Adobe programs for a reduced price. Adobe Photoshop is
released in two editions: Adobe Photoshop, and Adobe Photoshop Extended, with the
Extended having extra 3D image creation, motion graphics editing, and advanced image
analysis features. Adobe Photoshop Extended is included in all of Adobe's Creative Suite
offerings except Design Standard, which includes the Adobe Photoshop edition.

Alongside Photoshop and Photoshop Extended, Adobe also publishes Photoshop
Elements and Photoshop Light room, collectively called "The Adobe Photoshop Family".
In 2008, Adobe released Adobe Photoshop Express, a free web-based image editing tool
to edit photos directly on blogs and social networking sites; in 2011 a version was
released for the Android operating system and the iOS operating system.

File Format

Photoshop files have default file extension as .PSD, which stands for "Photoshop
Document." A PSD file stores an image with support for most imaging options available
in Photoshop. These include layers with masks, transparency, text, alpha channels and
spot colors, clipping paths, and duotone settings. This is in contrast to many other file
formats (e.g. .JPG or .GIF) that restrict content to provide streamlined, predictable
functionality. A PSD file has a maximum height and width of 30,000 pixels, and a length
limit of 3 Gigabytes.

Photoshop files sometimes have the file extension .PSB, which stands for "Photoshop
Big" (also known as "large document format"). A PSB file extends the PSD file format,
increasing the maximum height and width to 300,000 pixels and the length limit to around
4 Exabyte. The dimension limit was apparently chosen arbitrarily by Adobe, not based on
computer arithmetic constraints (it is not close to a power of two, as is 30,000) but for
ease of software testing. PSD and PSB formats are documented.

Because of Photoshop's popularity, PSD files are widely used and supported to some
extent by most competing software. The .PSD file format can be exported to and from
Adobe's other apps like Adobe Illustrator, Adobe Premiere Pro, and After Effects, to make
professional standard DVDs and provide non-linear editing and special effects services,
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such as backgrounds, textures, and so on, for television, film, and the web. Photoshop's
primary strength is as a pixel-based image editor, unlike vectorbased image editors.
Photoshop also enables vector graphics editing through its Paths, Pen tools, Shape tools,
Shape Layers, Type tools, Import command, and Smart Object functions. These tools
and commands are convenient to combine pixel-based and vector-based images in one
Photoshop document, because it may not be necessary to use more than one program.
To create very complex vector graphics with numerous shapes and colors, it may be
easier to use software that was created primarily for that purpose, such as Adobe
Illustrator or CorelDraw. Photoshop's non-destructive Smart Objects can also import
complex vector shapes.

Language Availabilities

Photoshop is available in more than 20 languages. These are the following:

Chinese Simplified, Chinese Traditional, Czech, Danish, Dutch, English, Finnish, French,
German, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Portuguese,
Romanian, Russian, Spanish, Swedish, Turkish and Ukrainian. Also Arabic and Hebrew
as of Photoshop CS6.

Plugins

Photoshop functionality can be extended by add-on programs called Photoshop plugins
(or plug-ins). Adobe creates some plugins, such as Adobe Camera Raw, but third-party
companies develop most plugins, according to Adobe's specifications. Some are free and
some are commercial software. Most plugins work with only Photoshop or Photoshop-
compatible hosts, but a few can also be run as standalone applications.

There are various types of plugins, such as filter, export, import, selection, color
correction, and automation. The most popular plugins are the filter plugins (also known
as an 8bf plugins), available under the Filter menu in Photoshop. Filter plugins can either
modify the current image or create content. Below are some popular types of plugins, and
some well-known companies associated with them:

 Color correction plugins
 Special effects plugins
 3D effects plugins

Adobe Camera Raw (also known as ACR and Camera Raw) is a special plug-in, supplied
free by Adobe, used primarily to read and process raw image files so that the resultant
images can be processed by Photoshop. It can also be used from within Adobe Bridge.
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1. What is Photoshop?

Adobe Photoshop is a professional image editing software package that can be used by
experts and novices alike. While this handout offers some very basic tips on using the
tools available in Photoshop, more comprehensive guidance can be accessed on the web
or in the help menu of your version of Photoshop. The version used for this tutorial is
Adobe Photoshop CS. 2. about the Work Area

The work area can be intimidating to work with because of all the complex functionality
but with a quick breakdown of the available features and their uses, you will be ready to
comfortably navigate the work area with ease. The work area in Photoshop has the
following basic functionality.

Features:

• Menu Bar – this is where you can access most of the commands and features in
Photoshop

• Drawing Palette – where the image being worked on will appear

• Options bar

• Content sensitive display of tool options – changes as different tools are selected

• Display using Window > Options or Click a tool in the toolbox.

Lasso options bar
• Tool box - for creating an editing images (display or hide using Windows > Tools)



• Palettes - to monitor and modify images (there are 5 palettes by default)

• Palette Well - to organize palettes in work area

• Drag a palette’s tab into the palette well to store it in the palette well

• Once in the palette well click on the palette tab to use it Web works.

3. Resizing Images and Size Guide

When working with images for a website, you will need to resize your images to suit your
particular purpose. Here is a basic guide that can help you decide on what is suitable.
(The units used here are pixels, which are standard units across all computer platforms.
The conversion between pixels and inches is roughly 1” = 72 pixels or 1cm = 28 pixels)
to use this particular unit of measure you will need to adjust your preference settings by
selecting Edit > Preferences > Units and Rulers and changing the units and rulers to
measure in pixels.

4. Selection

There are several ways to select images or portions of images in Photoshop. Here are
few basic methods to do so:

Adding to a Selection and making a square

• Use the rectangular Selection Tool on the Toolbox to select area to work on.

• To add to a selection, hold Shift before dragging.

• To make the selection exactly square, start dragging, then hold Shift.

• You can press Ctrl+D to "deselect" and remove the selection at any time.

Elliptical Selections and subtracting Selections

• Hold down on the Selection Tool on the Toolbar, and choose the Ellipse.

• To move the selection, just click inside it and drag.

• Holding Alt while selecting subtracts that area from the selection



5. Cropping
Cropping is the process of removing portions of an image to create focus or strengthen
the composition.

You can crop an image using the crop tool and the Crop command.

To crop an image using the Crop command:

• Select the part of the image you want to keep by doing one of the following:

• With the rectangle, rounded rectangle, or elliptical marquee, drag over the area you
want

To select.

• Hold down Shift as you drag to constrain the marquee to a square or circle.

• To drag a marquee from its center, hold down Alt (Windows) or Option (Mac OS) after
you begin dragging.

• Choose Image > Crop.

To crop an image using the crop tool:

• Select the crop tool.

• Press enter to apply the selection to the cropped area.

6. Modify Color and effects

Photoshop has many powerful tools to modify the color and effects of images. You should
experiment with a few options under the Filters menu to view a few of the available
effects. Some that you may like to try out are:

• To improve the appearance of an image you can simply select: Image> Adjustments >
Auto Levels/Contrast/Color

• Filters can be used to achieve a special effect. These are fun to play with! Some
examples are:

• Liquefy – to edit out unwanted areas of your pictures with colorful swirls

• Artistic Filters - to give artistic flare to a simple image



• Textures - to change the look and feel of an image

7. Layers

• The Layers window shows the various layers that your image is made up of. Workshop
Committee of Technology Assist by Students Web works

• To make a new layer, click the New Layer button (F) or selecting Layer > New > Layer
in the menu bar.

• The background layer cannot be removed, since it has to serve as the background” for
the entire image.

• To work on a different layer, click on that layer. The eyeball will appear next to that layer.

• You can drag layers up and down the list.

• Remember – create a new layer for each part of your image. This allows you to go back
and edit the layers individually.

Photoshop Layers palette:

A. Layers palette menu

B. Layer set

C. Layer

D. Layer thumbnail

E. Layer effect

F. new layer icon eyeball

8. Text Editing

To edit text on the type layer:

• Always use a new layer to create text

• Select the horizontal type tool or the vertical type tool.

• Select the type layer in the layers palette (which will appear with the icon next to it), or
click the text flow to automatically select a type layer.



• Click to set insertion point or select one or more characters you want to edit

• Enter text and format as desired using the character palette (display character palette
using: Window > Character or click Character palette tab if the window is open but not
visible)

• Commit changes to type layer by either:

• Click the Commit button in the options bar

• Press the Enter key on the numeric keypad.

• Press Ctrl+Enter on the main keyboard (Windows) or Command+Return (Mac OS).

• Select any tool in the toolbox, click in the Layers, Channels, Paths, Actions, History, or
Styles palette, or select any available menu command.

9. Gradients

Gradients are a great way to introduce flashy, eye-catching graphics in your pages. Word
of caution – use them carefully! Abusing gradients may result in confused visitors. Locate
this button on the toolbar and click on it. Notice that the toolbar underneath the menus
have changed to: Click on the small bar next to the mini-gradient (this is a preview of the
actual gradient), and a menu of various gradients will show up: You can also change the
properties of the gradient by clicking on the gradient preview box. A new dialog box titled
“Gradient Editor” will open. Picking any box is fine, but for now, just picks the box with an
orange background and a yellow stripe. Create a new image, and take your cursor and
drag it across. Depending on how you drag the mouse, you will get a gradient. Have fun
experimenting! Workshop Committee of Technology Assist by Students Web works

10. File type: GIF or JPEG

When considering what format to save images in there are three basic things to consider:
color, size and compression which affects the loading time. Making image files smaller is
useful for transmitting files across networks and for archiving libraries of images. This
saves disk space and improves transmission time. It takes longer to decode and view a
JPEG image than to view an image of a simpler format such as GIF. Thus using JPEG is
essentially a time/space tradeoff: you give up some time in order to store or transmit an
image more cheaply. GIF is superior in image quality, file size, or both. Editing tools Crop.

Dodge and Burn tools affect the tone, respectively lightening and darkening an area. Blur,
Sharpen, and Smudge affect the focus in a chosen area. Similar effects can be found in
"Filters." Clone stamp samples from another area. Good for removing specks and other
imperfections. Resample often and use short strokes when cloning a large area. Healing



Brush and Patch Tool are similar to Clone Stamp, but preserve lighting/shading and
texture. Avoid crossing into dissimilar (in tone or texture) areas.

Filters

Blur and Sharpen filters are often used in conjunction with selection tools. Best choices:

Gaussian Blur: Especially useful to de-emphasize background and foreground objects.
Motion Blur also works well.

Unsharp Mask. Increases contrast along perceived edges. "Threshold" determines how
high contrast must be to be affected (Default = 0, sharpens all; higher settings sharpen
only high-contrast areas). Unlimited special effects. Posterize, mosaic, emboss, halftone,
chrome, you name it…go nuts!

Optimizing for the Web

File size is more important for Web graphics, since download times are a consideration.
Since computer monitors are unable to display images at a resolution higher than 96 ppi,
images for the Web should be smaller files to begin with. Slicing images into pieces
further improves download time. HTML code for the resulting table becomes embedded
in the file. File sizes can be further reduced in a couple of ways: JPG is the format of
choice when subtle gradations of color are involved, as with a photograph. The amount
of detail lost in compression when saving as a JPG is controlled by choosing a low (small
file size), medium, or high (larger file size) quality file. Detail loss is cumulative, so
reworking and resaving JPEGs should be avoided. GIF is the best format for sharpedged
graphic images with flat, limited colors. GIFs also preserve transparency; JPGs do not.
Though "lossless" compression is used, GIFs are limited to 256 colors (8- bit). The size
of a GIF file can be reduced by further limiting the number of colors, by applying "lossy"
compression, or by a combination of the two methods. File sizes and estimated download
times for JPG, GIF, and PNG images can be previewed in Image Ready or by choosing
"Save for Web" in Photoshop.

Tools

Upon loading Photoshop, a sidebar with a variety of tools with multiple image-editing
functions appears to the left of the screen. These tools typically fall under the categories
of drawing; painting; measuring and navigation; selection; typing; and retouching. Some
tools contain a small triangle in the bottom right of the toolbox icon. These can be
expanded to reveal similar tools. While newer versions of Photoshop are updated to
include new tools and features, several recurring tools that exist in most versions are
discussed below.



Pen Tool

Photoshop includes a few versions of the pen tool. The pen tool creates precise paths
that can be manipulated using anchor points. The freeform pen tool allows the user to
draw paths freehand, and with the magnetic pen tool, the drawn path attaches closely to
outlines of objects in an image, which is useful for isolating them from a background.



Measuring and navigation

The eyedropper tool selects a color from an area of the image that is clicked, and
samples it for future use. The hand tool navigates an image by moving it in any direction,
and the zoom tool enlarges the part of an image that is clicked on, allowing for a closer
view.

Selection

By using path selection tool, we can select path nodes.

Cropping

The crop tool can be used to select a particular area of an image and discard the portions
outside of the chosen section. This tool assists in creating a focus point on an image and
excluding unnecessary or excess space. Cropping allows enhancement of a photo’s
composition while decreasing the file size. The "crop" tool is in the tools palette, which is
located on the right side of the document.

Slicing

The "slice" and slice select tools, like the crop tool, are used in isolating parts of images.
The slice tool can be used to divide an image into different sections, and these separate
parts can be used as pieces of a web page design once HTML and CSS are applied. The
slice select tool allows sliced sections of an image to be adjusted and shifted.

Moving

Once an area of an image is highlighted, the move tool can be used to manually relocate
the selected piece to anywhere on the canvas.

Marquee

The marquee tool can make selections that are single row, single column, rectangular
and elliptical. An area that has been selected can be edited without affecting the rest of
the image. This tool can also crop an image; it allows for better control. In contrast to the
crop tool, the "marquee" tool allows for more adjustments to the selected area before
cropping. The only marquee tool that does not allow cropping is the elliptical.

Lasso

The lasso tool is similar to the "marquee" tool; however, the user can make a custom
selection by drawing it freehand. There are three options for the "lasso" tool – regular,
polygonal, and magnetic. The regular "lasso" tool allows the user to have drawing
capabilities. Photoshop will complete the selection once the mouse button is released.
The user may also complete the selection by connecting the end point to the starting
point. The “marching ants” will indicate if a selection has been made. The "polygonal
lasso" tool will only draw straight lines, which makes it an ideal choice for images with
many straight lines. Unlike the regular "lasso" tool, the user must continually click around
the image to outline the shape. To complete the selection, the user must connect the end



point to the starting point just like the regular lasso tool. "Magnetic lasso" tool is
considered the smart tool.

Quick Selection

The quick selection tool selects areas based on edges, similarly to the magnetic lasso
tool. The difference between this tool and the lasso tool is that there is no starting and
ending point. Since there isn’t a starting and ending point, the selected area can be added
on to as much as possible without starting over.

Magic Wand

The magic wand tool selects areas based on pixels. The user only needs to click once,
and this tool will detect pixels that are very similar to each other. If the eye dropper tool
is selected in the options bar, then the magic wand can determine the value needed to
evaluate the pixels; this is based on the sample size setting in the eyedropper tool. When
the image requires more than a few clicks, this tool becomes a disadvantage. The user
must decide what settings to use or if the image is right for this tool.

Eraser

The eraser tool does exactly what it’s called. It erases an image based on the layer it is
on. If the user is on the text layer, then any text that the tool is dragged across will be
erased. The erased area will convert the pixels to transparent, unless it is the background
layer. The size and style of the eraser can be selected in the options bar. This tool is
unique in that it can take the form of the paintbrush and pencil tools. In addition to the
straight eraser tool, there are two more available options – background eraser and magic
eraser.

Typing

Photoshop also provides tools for adding and editing text. The type tools create an area
where text can be entered, and the type mask tools create a selection area that has the
shape of text. The type tool creates vector-based text, so symbols, letters and numbers
in various fonts and colors can be re-sized while maintaining the same quality.

Retouching

There are several tools that are used for retouching, manipulating and adjusting photos,
such as the clone stamp, eraser, burn, dodge, and smudge and blur tools. The clone
stamp tool samples a selected portion of an image, and duplicates it over another area
using a brush that can be adjusted in size, flow and opacity. The smudge tool, when
dragged across part of an image, stretches and smudges pixels as if they are real paint,
and the blur tool softens portions of an image by lowering the amount of detail within the
adjusted area.

Content-aware

Content-awareness is a useful aspect of Photoshop where image editing is done
automatically and intelligently. It comes in two forms, content-aware scaling, and content-
aware filling, in which elements in a background automatically recompose according to
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the areas a user of the program decides to fill or scale. More specifically, content-aware
scaling works by rescaling an image and causing its content to adapt to the new
dimensions and preserving important areas of it. Content-aware filling functions by
matching tone, color, and noise of an area of the image that contained an object or detail
in which the user decides to remove.

Healing tools

With improvement retouching tools like the Clone Stamp tool and Healing Brush tool,
imperfections of an image can easily be removed. These tools essentially function by
locating a source point (or multiple source points) that can be scaled or rotated in order
to cover an imperfection or unwanted detail in a specific area of an image.

Puppet wrap

Similar to the content-aware tool, the puppet warp tool reveals Photoshop’s intelligence
by allowing a user to reposition an object in an image such as a flower or arm. This is
done by using points that outline the structure of an object and easily repositioning in the
wanted orientation.

Video Editing

In Adobe CS5 Extended edition, video editing is comprehensive and efficient with a broad
compatibility of video file formats such as MOV, AVI, MPEG-4, and FLVformats and easy
workflow. Using simple combination of keys video layers can easily be modified, with
other features such as adding text and the creation of animations using single images.

3D

With the Extended version of Photoshop CS5, 2D elements of an artwork can easily
become three-dimensional with the click of a button. Extrusions of texts, an available
library of materials for three-dimensional and even wrapping two-dimensional images
around 3D geometry are all possible with this version of Photoshop. Realism can also be
added to an image using the 3D features of Photoshop such as animating imagebased
lights and depth of field.

Mobile integration

Third-party plugins have also been added to the most recent version of Photoshop where
technologies such as the iPad have integrated the software with different types of
applications. Applications like the Adobe Eazel painting app allows the user to easily
create paintings with their fingertips and use an array of different paint from dry to wet in
order to create rich color blending.

Camera Raw

With the Camera Raw plug-in, RAW images can be processed without the use of Adobe
Photoshop Light room, along with other image file formats such as JPEGs, TIFFs, or
PNGs. The plug-in allows users to remove noise without the side-effect of
oversharpening, add grain, and even perform post-crop vignetting.
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WEB SCRIPT LANGUAGE HTML
Introduction to HTML

HTML (Hypertext Markup Language) is used to create document on the World Wide

Web. It is simply a collection of certain keywords called ‘Tags’ that are helpful in writing

the document to be displayed using a browser on Internet. It is a platform independent

language that can be used on any platform such as Windows, Linux, Macintosh, and so

on. To display a document in web it is essential to mark-up the different elements

(headings, paragraphs, tables, and so on) of the document with the HTML tags. To view

a mark-up document, user has to open the document in a browser. A browser

understands and interpret the HTML tags, identifies the structure of the document

(which part are which) and makes decision about presentation (how the parts look) of

the document.HTML also provides tags to make the document look attractive using

graphics, font size and colors. User can make a link to the other document or the

different section of the same document by creating Hypertext Links also known as

Hyperlinks.

WEBDESIGNING
Website: Collection of WebPages and WebPages is made by HTML Tags.

Internet: 24 Hours presence on Internet with World Wide Reach.

Web designing: Static Site:Without Database | Photoshop (Web Templates /

Homepage)

HTML | DHTML Dreamweaver | Flash Animation | Css & Div Tag.

Web development: Dynamic Site: Database Site | Java Script | ASP.NET | PHP | Ms-

Access | MySQL | Sql Server

Requirement for Website: Domain Name | Hosting (Server Space) | Website

HTML - Hyper Text Markup Language The language used to develop web pages is
called HTML. HTML is the language interpreted by a Browser. Webpage are also called

html documents. HTML is a set of special codes. HTML is specified on TAGS.

For creation of HTML files we required two ways:



Editor: For writing purpose or making HTML files Note Pad is best editor it is
support coding language.

Browser: For output display there are of two type of browsers Internet Explorer
and Netscape Navigator.

The contents of HTML page are written in Tags / Attributes.
HTML Tags: Tags are instructions that one embedded directly into the text of the

document. An HTML tag is a signal to a browser that it should do something other than

just throw text up on the screen. By connection all HTML tags begin with an open angle

bracket (<) and end with a Closes angle Bracket (>) HTML tags can be of two types:

Paired Tags: A tag is said to be paired tag if it, along with a companion tag, close the
text.

Singular Tag: The second type of tag is the singular or stand-alone tag. It does
not have a companion tag.

Tag Attributes & Value: Additional information supplied to an HTML tag is
known as Attributes of a tag. Attributes are written immediately following the tag,

separated by a space. Like:

<HR Size=5 Color=”Red” Width=70% Align=”Right”>

Here HR = Tag

Size, Color, Width, Align = Attributes

5, Red, 70%, Right = Values

Basic structure of HTML Document:

Every HTML program has a rigid structure.

<HTML> Start Tag | Opening Script

<HEAD> Information placed in this section is essential to the inner working of

the document and has nothing to do with the content of the document. <TITLE>
Explanation of page purpose, Display in Title Bar of I.E.

</TITLE> Closing Tag

</HEAD> Closing Tag

<BODY> Information and Links / Secondary Links / Footers mean any type of
Text or Graphics for Page.



</BODY> Closing Tag
</HTML> Closing Tag | Closing Script

Paragraph Breaks: A blank line always separate paragraphs in textual material. The tag
that provides this functionality is <P>.<P>tag is used to create a new paragraph.

Line Breaks: When text needs to start from a new line and not continue on the same
line, the <BR> tag should be used.

Heading Style: HTML supports six different levels of headings. The highest-level header
format is

<H1> and the lowest level is <H6>.

Align Attribute: Alignment attributes are often used with the text, image.
Align = Left / Center / Right <H1 Align=”Left”> Soft Brain</H1>

Drawing Lines: The tag <HR> draws lines and horizontal rules. The Attributes to the
<HR> tag are:

<HR Size=5 Color=”Red” Width=70% Align=”Right”>

Text Level Elements: Text level Elements changes the appearance to function of text.
Bold: Bold element <B> and </B> causes text to appear in a bold type face.

<B> Soft Brain </B>

Italic: Italic element <I> and </I> causes the text to appear in Italic type face.

<I> Soft Brain </I>

Underline: Underline element <U> and </U> causes text to underline. <U>
Soft Brain </U>

Strike: Strike element indicates that text enclosed in <S> and </S> will have
a line drawn in the middle of text.

<S> Soft Brain </S>
Teletype: Teletype element changes the font like a monospaced type writer font.

<TT> Soft Brain </TT>



Superscript: Raised one point text upper word 15th August or Soft BrainTM .

15 <SUP> th </SUP>August 15th August

Subscript: Text Raised down one point downward.

H<sub>2</sub>SO<sub>4 </sub> H2SO4

Controlling Font Size and Color: All text specified within the tags <Font> and </Font>
will appear in the font size and color as specified as attributes of the Tag <Font>The
attributes:

Face = Sets the font to be specified font name.
Size = Sets the size of the text. Size can take values between 1 to 7.
Color = Sets the color of the text.

<Font face=“Arial” size=4 color=”green”> Soft Brain Informatics Technology Pvt.Ltd.
</Font>

Bgcolor Attributes: Specifies background color using color name.
<Body Bgcolor=”RED”>

Text Attributes: Specifies foreground color or the color of the text.
<Body Text=”Aqua”>

Using Special Characters:

LIST STYLE
Lists are the best method of organizing information and presenting it in a structure

fashion basically there are three kinds of lists. They are:

Ordered List (Numbering): An ordered list start with the tag <ol> and ends with </ol>.
Each List Item<Li>start with tag <Li>.If tag <Li>is not present at the beginning; the listed

items appear on the same line.

Non-breaking space &nbsp;
Copyright Sign &copy; Copyright ©
Registered Trademark &Reg; Soft brain ®

Trademark & #8482; Soft brainTM



Using Attributes: Type Attribute type=”1” will give
Counting numbers (1, 2..........) type=”A” will give Uppercase
letters (A, B.........) type=”a” will give Lowercase letters
(alb..........) type=”I” will give Uppercase Roman numerals. (I, II,
III......) type=”i” will give Lowercase Roman numerals.

(ixia....... )

Start Attribute: The start attribute allows you to specify the beginning of the list’s
numbers. (Start=”1”)

Unordered List (Bullet):We use the tag <UL> and </UL> for unordered List.

Attributes of Unordered List

type=”circle” type=”square” type=”disc”

Definition list: The definition list uses the <DL> start tag and the </DL>end tag to create
a definition list. Definition list consists of two parts.

Definition term=Appears after the Tag <DT>

Definition description=Appear after the Tag <DD>

Result in Internet Explorer: KEYBOARD AN INPUT DEVICE

ADDITON OF GRAPHICS / IMAGES IN HTML DOCUMENTS
Other than text, HTML allows placing of static and animated images in an HTML

page.

The commonly used image file types are GIF (Graphic Interchange Format) JPEG (Joint

Photographic Experts Group) also called as JPG. To add an image in HTML document,

you just need to include the <IMG> tag with a reference to the desired image. The

<IMG> (image) tag is an empty element (i.e. it doesn’t require a closing tag).

<IMG SRC=”imagename.gif”>

<IMG SRC=”imagename.jpg”>

Image Element Attributes:

Align Attributes with Text: Align=Top / Middle / Bottom



E.g.: <Img align =”middle” src=”picture.gif”>

Align Attributes with Floating Image: Align=Left / Right

Border: specifies the size of the border to place around the image.
Height: specifies the height of the image.

Width: specifies the width of the image.

Hspace : indicates the amount of space to the left and right of the image.

Vspace : indicates the amount of space to the top and bottom of the image.

Alt Attribute: ALT attribute for the <IMG.....>tag allows for substitution of a description

string of text to hold the place of the image.

<Img Alt=”Success Is A Journey” Src=”Image.jpg”>

Alt working for text

<a href=”filename.html” title =”Success Is A Journey” >link content</a>

CREATING TABLES
Table present information in the form of rows and columns. To include a table in your
web pages you first need to create the table structure and for that you use HTML’s Table
Tags.

<TABLE> The table’s beginning with a <TABLE>tag and the end with a
</TABLE>tag.

<TR> The table row element <TR>with an optional </TR>end tag creates a
horizontal row of cell.

<TH> The table heading <TH>with an optional </TH>creates leading cells.
<TD> The table data element <TD>tags with an optional </TD>end tag.

Table Attributes : <Align>Attribute:

<Table Align=”Left” / ”Center” /”Right”>

<Border>Attribute : <Table Border=5>

Bgcolor Attribute: <Table Bgcolor=”Color Name or Color Value”>

<Tr Bgcolor=”Color Name”>



<Td Bgcolor=”Color Name”>

<Th Bgcolor=”Color Name”>
Background Attribute: This sets an image on the Background of table.

<Table Background=”Computer.jpg”>

Caption: This tag is optional and it contains tables description.
<Caption Align=Top/Bottom/Left/Right>Caption Text</Caption>

Width & Height Attribute: <Table Width=”300” Height=”400”>

Cell spacing Attribute: You can use cell spacing attribute to control the spacing
between each cell in the table.

<Table Cell spacing=”Number”>

Cellpadding Attribute: (Spacline between cell content and cell border)

<Table Cellpadding=”Number”>

Rowspan Attribute: The rowspan attribute is used in a cell to make the cell’s
content merge with another cell in a row.

<Td Rowspan=”Number”> <Th Rowspan=”Number”>

Colspan Attribute: Similar to ROWSPAN, COLSPAN attribute is used in a cell to
make the cells content merge with another cell in a column.

<Td Colspan=”Number”> <Th Colspan=”Number”>

LINKING DOCUMENTS

LINKS: HTML allows linking to other HTML documents as well as images.

Clicking on a Section of text or an image in one webpage will open an entire webpage or

an image. The text or an image that provides such linkages is called Hypertext, a

Hyperlink or a Hotspot. Every Hyperlink.

1. Appears in blue color.

2. The hyperlink text / image is underlined.

3. When the mouse cursor is placed over it, the standard arrow mouse cursor changes
to the shape of a hand.



The blue color, which appears by default, can be over ridden. To change these

link colors there are three attributes that can be specified with the <BODY>tag. These

are:

Link: Change the default color of a hyperlink to whatever color is specified with this tag.
Alink :( Active Link) Changes the default color of a hyperlink that is activated to whatever
color is specified with this tag.

Vlink: (Visit Link) Changes the default color of a hyperlink that is already visited to
whatever color is specified with this tag.

The Anchor Tag: Anchor elements are used to link between two or multiple HTML
documents.”Anchor” tag starts with <A>and enclose with </A>.The <A>tag requires the

HREF attribute and (hyperlink reference) attribute accepts the URL of the linked page.

<A HREF=”filename.html”>content</A>

Every hyperlink has two components: The source and the destination.

<a href=”http.// www.yahoo.com/”>OPEN YAHOO SITE</A>

Images As Hyperlink: Just as text can act as a Hyperlink, so also images can act as
hyperlinks.

<A href=”abc.html”><img src=”image.jpg”></A>

External Link: links with other html document.
Internal Link: link in a same document. The anchor element is used to create both
external and internal links.

Name Attribute: Named Anchor is used to create links to a specified section within
document.

This is a two step process: At Top of page after Body Tag

<A NAME=”LOCATION”>

At bottom of page before Body Tag

<A HREF=”#LOCATION”>Content</A>

MARQUEE

http://www.yahoo.com/


Marquee Tag: For scrolling text and image.
<Marquee>-----------------------</Marquee>

Marquee Attributes

<Marquee behavior=”slide”> </marquee>In this text scrolls for one time only.
<Marquee behavior=”alternate”> </marquee>In this text will scroll continuously left
to right.

<Marquee behavior=”scroll”> </marquee>In this text will scroll continuously.

For direction of scrolling

<Marquee behavior=”slide” direction=”right”/”up”/”down”>
For background color/width/height

<Marquee behavior=”slide” bgcolor=”red” direction=”right” width=”500”
height=20>

For speed controlling in marquee

<Marquee scroll amount=1 maximum slow & 1000 maximum fast>
<Marquee scroll delay=1000 maximum slow & 1 maximum fast>

MULTIMEDIA
Multimedia refers to “Multiple Medium” that is the ability to add sound and moving

pictures to your WebPages.

Adding Video : <embed src="movies.mpg" height="200" width="200" >

Adding Sound:Webpage contain basically two varieties of sounds that play

whenever the visitor accesses the WebPages that is the background sound, and when

the visitor clicks something. The most common sound file formats are MIDI (Musical

Instrument Digital Interface), WAV (as in Wave), AU (Audio) and (Audio Interchange File

Format).

Sound files can be added in many of the ways. We can use the <A> anchor tag so
that the visitor has the option whether to hear the sound or not. For example:

<A href=”music.wav”> Click Here For Background Music </A>



As the user clicks on the text, the background sound starts. So the visitor has the
option whether to hear the sound or not.

Second option requires <Bgsound> tag : <Bgsound src=”Sound url”>
Here the src attribute specifies how many times the sound should play. If loop is

specify loop = No or infinite to play the sound is an endless loop.

Adding Animated Gif’s : (Graphics Interchange Format)

<img src=’A.gif” width = 100 height = 100>

FORM Creation in HTML
Creating A Form:WebPages can be interactive if they collect information from

the user. An HTML form is used for creating interactive web pages. The information

entered by the user is passed back to a web server where it might be recorded in a

Database for further use.So; a form is simply a collection of fields of information. These

fields of information can be in the form of text boxes, radio buttons, pull down menus

etc.Common uses of forms are Online order forms, Feedback forms-mail registration

forms, or any web page in which input is required from the user in order to complete a

given task. An HTML form consists of two parts. The first part, the user can see and

which he fallout and next one is the part, the user can’t see the second part specifies

how the server should process the user’s information. Here we commonly used PHP

script.

The Form Tag: A form must start with a <FORM>tag and end with a </FORM>tag. It has
mainly two attributes:

1. Action

2. Method

Syntax :<Form action=”URL” method=get/post>Form

Elements............</Form>

Action is used to specify e-mail address that will receive the form information. If

you have written a form handler to which the data in the form will be sent, then you will

have to add an action=”URL” attribute to specify the location of the handler.



The Method attribute tells the browser how to send the user’s data to the server.

There are only two possible values for the method attribute: Method=”get” or

Method=”post’. The default value is “post”.

Using Form Control Elements: The form element can contain different elements to
create form controls.

Input Element: The <input>tag allows user to input information.

Text: Used to create the single line text boxes.
Password: Similar to text, except the characters you type are not seen on screen.

Checkbox: As on or off switch.
Radio: Similar to a checkbox, except that in a group of radio buttons only one radio

button can be on at a time.

Submit: Submits a form to be processed.

Reset: Clears all the input on a form.

Button: creates a button similar in appearance to a submit button.
File: Can be used to send a file from the surfer’s computer along with the rest of the form
data.

Form Creation:

Fieldset and legend tag : <Fieldset> tag is used to group more form controls together.

The <legend> tag, which is optional these tags require closing tag. The Syntax is:

<Fieldset>

<Legend>Group Label Text</Legend>

Control 1 Control 2 Control 3 Control 4

</Fieldset>

<html>

<head><title>Feedback Online Form</title></head>

<body bgcolor=”black” text=”white”>

<form>

<fieldset>

<legend align=”right”>Form info@softbrain.org</legend>

mailto:info@softbrain.org


Input Element: The <input>tag allows user to input information. The <input>element
consists of <input>tag along with type attribute (to specify what type of form control you

want), the Name attribute (to indicate the field name), and other optional attributes. The

type attribute can accept text, checkbox, radio buttons etc.as its value. Below is a list of

all possible values of Type.

<input type=”text” name=”text-id” value=”default-text” size=”n”
maxlength=”n” read only>

The name attribute is used as an identifier for the contents of the form

component when the form is submitted. This name is not visible to the user and must be

unique within the form. The value attribute is optional and is used to supply initial text to

the text field. The content of this attribute will be shown on the text field, unless the user

changes it. We can specify the physical size of the text input box by using size attribute.

The default value is usually a length of 20 characters. You can, also set the number of

characters a user can input. The maxlength attribute does this. This setting should not

be less than the value of the size attribute. Otherwise your user won’t be able to type to

the end of the box and might get confused. The default value of maxlength is unlimited.

The read only attribute is used to disable the contents of the text. The <label> tag is
used for given bold heading names in form.

Text field: the most common type of form<input>is text. It presents the user with a
prompt for a single line of text. These fields are commonly used for a name, address,

email address etc.

<input type=”text” name=”text-id” value=”default-text” size=”n” maxlength=”n”>

<label>Full Name</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;

<input type=”text” name=”t1” size=25 maxlength=25 value=” ” ><br>

<label>Full Address</label>



&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;

<input type=”text” name=”t2” size=25 maxlength=25 value=” ” ><br>

Checkbox: A checkbox is simply an empty box and contain a checkmark when

activated. An input tag with attribute type=”checkbox” offers the user an “on” or “off”

switch. It is similar to a radio button, but any number of checkboxes may be switch on at

same time. If a checkbox is switched “on” when the form is submitted, its value attribute

is submitted as the form data for the named form component. Each checkbox has a

separate name specified by the name attribute. The syntax is:

<input type=”checkbox” name=”box id” value=”checkbox” checked>

<label>Internet / E-Shopping</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="checkbox" name="c1" value="checkbox" checked>

&nbsp;&nbsp; Computer&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<input type="checkbox" name="c2">

&nbsp;&nbsp;Laptop&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<input type="checkbox" name="c3">

&nbsp;&nbsp;Ipod&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<input type="checkbox" name="c4">

&nbsp;&nbsp;UPS&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<input type="checkbox" name="c5">

&nbsp;&nbsp;Mobiles&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;<br>

Radio Button: Radio buttons allows the user to choose one of the several options. On
selecting one of the options the other options are automatically deselected. The buttons

appear as small circles. With prompt and the selected one appears with a solid dot in it.

You can indicate the default choice by using a checked attribute. You have to use a

unique value for the name attribute for all radio buttons in a particular set. Syntax:



<input type=”radio” name=”radio id” value=”radiobutton” checked>

<label>Gender</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp; <input
name="radiobutton" type="radio"
value="radiobutton">&nbsp;&nbsp;&nbsp;&nbsp;Male
&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&n bsp;&nbsp;&nbsp;&nbsp;

<input name="radiobutton" type="radio"
value="radiobutton">&nbsp;&nbsp;&nbsp;&nbsp;Female<br>

Pull down Lists: This element creates a menu control. Using this either a drop down
menu or a list box can be displayed in the web page. Also this element must contain

more than one option. Here you use <Select> instead of <Input> and it has a closing

tag</select>. These fields allow user to select single or multiple responses..The name

attribute establishes a name for the select field and is used for form processing. The

size option is simply the number of options you want to show in the window. By default,

its value is one specifying size value greater than one turns the pull down list into a

scrolling list. You can use the multiple attribute to set the select field to accept only one

option. To select multiple options press Ctrl Key and click on the options. The <Option>

tag includes the list items. For each list item, there must be an <Option> tag. The

closing tag is optional. You can use Value attribute to specify the text to be submitted

when the particular item is selected. Use selected attribute to indicate the default menu

item.

<label>Year</label>

<select name=”Text id” size=”n” mulitple>

<option value=”Choice Id 1” selected>2000</option>

<option Value=”Choice Id 2”> 2001 </option>

</select>



<label>Date of Birth</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;MM&nbsp;&nbsp;&nbsp;

<select name="s1" size=1>

<option name="01">january</option>

<option name="02">february</option>
<option name="03">march</option>

<option name="04">april</option>

<option

name="05">may</option></select>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

DD&nbsp;&nbsp;&nbsp;

<select name="s2" size=1>

<option name="01">01</option>

<option name="02">02</option>

<option name="03">03</option>

<option name="04">29</option>

<option name="05">30</option></select>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

YY&nbsp;&nbsp;&nbsp;

<select name="s3" size=1>

<option name="01">2001</option>

<option name="02">2002</option>

<option name="03">2003</option>

<option name="04">2004</option>

<option name="05">2005</option>

</select><br>



Text Area Tag: It is an extension of text element. The input element type=”Text” creates
a single line text box and Textarea tag creates a multiple line text box. It sets an area

with in a form in which the user can type a larger section of text. The text area tag

presents a multiple text window with the size specified by the rows and cols attributes.

Rows give the height and cols give the width of the text area.

<Textarea name=”text-Id” rows=”n” cols=”n”>Type any Text here... </Textarea>

<label>Type Your Message Here</label><br>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp

;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n

bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<textarea name=”ta” rows=15 cols=60></textarea><br><br>

File Control: This control lets the user submit a file on their computer along with the
form. The size attribute specifies the physical size of the fields input box. The accepts

attribute is used to restrict the file types allowed in a file upload.

<Input type=”file” name=”file-id” size=”n” accepts=”file-type”>

<label>attaches your Resume</label>

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;
<input type="file" name="file"><br><hr>

Password: Password field is exactly similar to text field, except that it displays ****
(asterisks) instead of the actual input. These fields are mainly used for confidential

contents.

<input type=”password” name=”passwordid” value=”default text”>

<label>Login : </label><br>

<label>User



Name<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&n
bsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p

;&nbsp;&nbsp;&nbsp;

<input type="text" name="t1" size=25 maxlength=25 value=" " ><br>
<label>Password<label>&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbs
p;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&

nbsp;&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;

<input type="password" name="pass" size=25 maxlength=25><br><hr>

Button Value: Creates a button similar in appearance to a submit button, exept that this
kind of button doesn’t do anything in particular. Using button value of type attribute you

could have buttons of your choices. You normally require these buttons for executing

various scripts. These buttons have no default functions like submit & Reset. The name

attribute assigns a name to the button and is used for form processing. The value

attributes accepts a text that appears on the button. The button size will be controlled

directly by the text length. The ONCLICK attribute gives the name of the script that is to

be activated when the button is clicked.

<Input type=”button” name=”button id” value=”click here”
onclick=”Script”>

Image Button: Exactly the same as a submit button, except that you can specify any
image instead of the normal gray button appearance. An input element with

type=”Image” creates an image button. Instead of text an image of your choice is

displayed. The attributes for an image button are similar to the attributes for <IMG> tag.

Here you have to specify SRC or Images for aligning them in left, center or right

<input type=”image” name=”img” src=”pic.jpg” height=50 width=100>

Submit Button: Every form must have a submit button as after filling up the form, the

visitor needs to submit the information to you. An input tag with type=”Submit” provides

a button that submits the information in the complete form to the URL, given as the



action attribute of the form tag. By default, “Submit” is written over the button is taken

from the value attribute. The button size will be controlled directly by the text length.

<input type=”submit” name=”sub” value=”Submit”>

Reset Button: The reset value of the type attribute cleans all form entries to the default

once or leaves them blank if no defaults are specified. As the reset button can simply

wipe off all the work done, therefore it should be well labeled and should never be

placed before submit button.

<input type=”reset” name=”res” value=”Reset”>

</fieldset>

</form></body></html>

FRAMES
Frames are used to create a document that divides the browser window into different

parts and display a different web page in each of them. A frame set document is a

document that defines one or more frames by using frameset and frame elements.

Frames can communicate with each other so that an action performed on a page in one

frame can change the contents and behavior of another frame. A common frame layout

uses an index frame with links on the left, and a content frame on the right. As you click

on the links on the left frame, the corresponding HTML page will appear on the right

frame. One frame can be used to keep some information static while the other frame

can contain the actual content of different sections of website.

The <Frameset>Tag: The splitting of a browser screen into frames is accomplished
with the <frameset>and </frameset>tags embedded into the HTML document. The

<frameset>tag required one of the following two different attributes depending on

whether the screen has to be divided into rows or columns.



Rows & Cols: Row attribute is used to divide the screen into multiple rows. Cols

attribute is used to divide the screen into multiple colums.It can be set equal to a list of

values. Depending on the required size of each Rows and Columns. The value can be:

1. A number of pixels.

2. Expressed as a percentage of the screen resolution.

3. The symbol,’*’ which indicates the remaining space.

Example :<Frameset Rows=”50%,50%></Frameset>

Result: It divides the browser screen into two equal horizontal sections.

<Frameset Cols=”50%,50%></Frameset>

Result: It divides the browser sceen into two equal vertical sections.

The <frame>tag: Once the browser screen is divided into rows (horizontally) and
columns (vertically), each different HTML document. This is achieved by using the

<Frame>tag which takes in the following attributes:

Name=”name”: Gives the frame a unique name so it can be targeted by other
documents. The name given must begin with an alphanumeric character. <Frame
Name=”AA”>

Src “Url”: Indicates the URL of the document to be loaded into the frame.

Creating Framed Documents: Creating frames is actually quite simple. First of all you
need to decide as how you want to divide the browser’s window of the webpage. Then

write the html document that you want to put in the page segments. In addition to this a

master document is to be written which is used to specify what goes where. Suppose

we want to divide a page into two rows and four columns. Then the HTML code for the

frameset will be:

<Html>

<Head><title>FRAME ONLINE....</title></head>

<Frameset>

<frameset cols="30%,*">



<frameset rows="50%,50%">

<frame name="aa">

<frame name="bb">

</frameset>

<frameset rows="50%,50%">

<frame name="cc">

<frame name="dd">

</frameset>

</frameset>

</frameset>

</html>
The <Frameset>and <Frame>tag: The master page doesn’t have a <body> tag.
Instead, it uses

<Frameset> tags. The <Frameset>tag is included after the <Head>tag and it

established frames within the HTML document. It does all the dividing. It requires a

closing tag and there may be any number of frameset tags within an HTML document.

The cols attribute is used for vertical frames whereas the rows attribute is used for

horizontal frames. The width or height is specified as a comma-delimited list of sizes in

pixels, percentage or as a proportion of the remaining space by using “*”.

Another basic tag is the <FRAME>tag. It contains the frame content and it tells the
browser what to put in each frame. Each frameset must include a

<FRAME>definition for each division. As in our example there were four partitions and so
four <FRMAE>tags. Notice that frame does not have a closing tag.



Frame Border Attributes: By default, most browser use a frame border. Border
attributes that control the frame border. To turn off frame border set border=0 and for

turn on border set border=8.You can use these attributes both in the <frameset>or

<frame>tags. To remove all the borders from your frames add them in the

<frameset>tag and to remove the border from individual frames include these attributes

in the corresponding<frame>tag. You can also set the color of the border by Just add

bordercolor=”purple”.

Controlling Scroll Bars: Scrolling controls the appearance of horizontal and vertical

scroll bars in a frame. This takes the value Yes / No / Auto.

In simple words, if the frame’s content goes beyond the frames width, most

browsers add scroll bars so that the user can see the full content. Even through scroll

bars are useful to see the entire frame’s content, sometimes they can be unnecessary

and visually disturbing. You can control the use of scroll bars in a frame by including

scrolling attributes.

Yes means the frame gets scroll bars-whether they are needed or not.

No means there will be any scroll bars, even if your frame content is much large.

The browser will simply display as much as it can.

Auto is default If scroll bars are needed, they appear, it they are not needed they
stay conveniently out of the way.

Targeting Named Frames:Whenever a hyperlink which loads a document in a frame is

created, the file referenced in the hyperlink will be opened and will replace the current

document that is in the frame.

In a situation where the new document needs to be opened in a different frame

while keeping the document from which the new document was browser open in a

different frame, a simple HTML coding technique must be used.

Since the hyperlink must open an HTML file in another frame, the frame in which

the HTML file is to be opened need to be named. This is done by using the name

attribute of the <FRAME>tags. The name takes one parameter, which is the frame

name. The hyperlink tag will have to be supplied with the following information:



1. The filename.html file that has to be opened.

2. The name of the frame where the filename.html file has to be opened. The

attribute via which the frame name is specified is the TARGET attribute, which is a

part of the <A> </A>tag. This information is given as: TARGET=”framename” <a
href=”filename.html” TARGET=”framename”>Link Content</a>

WEB EDITOR NOTEPAD
There will be times when you will want to edit textual files. Textual files are different from
documents created by WordPad, Word, WordPerfect or some other word processing
program in that they contain no imbedded codes. Editing these files with a word
processing program can introduce special characters that make these files unusable.
Instead, use Notepad which allows you to edit the file as pure text.

Textual files will normally have a TXT file extension, but there are several special purpose
files in Windows that must be pure text. Some of the more important of these include your
CONFIG.SYS, AUTOEXEC.BAT,WIN.INI and SYSTEM.INI (These files existed in earlier
version of Windows, but have been eliminated in Windows XP). You may get to the point
of wanting to play with these files. If so, use Notepad to edit these and not WordPad as
your system cannot use the resulting WordPad file. If you decide you want to create a
web page, but don't have an HTML editor, you will want to use Notepad so as not to
introduce those nasty characters associated with WordPad, etc.

In addition to having a tool to use in editing those special files on your system, learning
Notepad can provide a good foundation for learning some of the other tools that come
with Windows 95/98/ME/XP as well as a number of the applications that you may want
to add to your system later. Notepad is simple to learn but has some features in common
with other programs.
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The first thing I want to point out in the above is that I have entered some text into
Notepad. Okay, let's look at some of the features of Notepad. Let's start off by looking at
each of the menus across the top of Notepad. Before we go to the individual menus,
notice something about the menu bar itself. See the underlined letters in each of the menu
items (File, Edit, Format, View, etc.) (Under Windows XP, the underlines are only visible
when you hold down the <Alt> key - previously the underlines were always visible)?
These are meaningful. If you hold down the <Alt> key and press these letters, you will
select that menu. Obviously you can select each menu with the mouse, but this gives you
an alternative way of getting into them. So, you can get into the File menu by pressing
<Alt>F.



File Menu

This is the File menu. Notice a couple of things about this menu. Notice the "..." at the
end of several selections. This indicates that selecting these items will take you to a dialog
box that will allow you to carry out that operation. Notice the code down the right side of
the menu - Ctrl+N, Ctrl+O, etc. These are hotkeys you can use from within the document
without having to go into the menu. For example, holding the <Ctrl> key down and
pressing N is the same as going into the File menu and selecting New. These hotkeys
can save you some time in getting to these functions. I wouldn't try to memorize these
hotkeys right now, but just make a mental note of them - you'll learn them over time as
you find them appropriate to your situation.

New - This will start a new document. If you are currently working on a document that you
haven't saved, the system will prompt you to save the old document before starting a new
one.

Open... - This allows you to bring an existing document into Notepad to view and/or edit
it. You'll see the following dialog box when you make this selection:



This is the standard Open dialog box used by most Windows programs. It consists of a
toolbar across the top that shows you which folder you are currently in along with a couple
of control buttons for getting to where you want to go. The main part of the Open dialog
box shows you the files/folders that match the criteria for this application. Next is where
the system will tell you the name of the file it thinks you want. Right now, it doesn't know
so it assumes you want to look at all TXT files. Next is where you can tell the system what
type of files you are interested in looking at. By default, Notepad looks at Text Documents
(*.TXT), but you can change this to look at anything else. Finally, you can either Open
the selection or Cancel this operation.

Save - If you are making modifications to an existing file, Save will put the changes back
into the file after confirming that you really want to make the changes. If the file you are
working on is a new file, Save works the same as Save As....

Save As... - Save As. Brings up a dialog box similar to the Open dialog box above.



In Notepad you get to save the file wherever you want, but the best place would be in My
Documents. It's easy enough to change folders and save a file anywhere on the system
you want. See Naming a File for some suggestions on how to organize your data.

Page Setup... - The Page Setup... dialog box allows you to customize some of the things
you see when you print your document. For example, you can change the size of your
paper; customize the header and footer on each page as well as the margin at the top,
bottom and either edge of the paper. The Page Setup... dialog box looks like this:

Print... - This is a standard print operation. It brings up the Print dialog window where you
can modify the printer information.

Exit - This shuts down Notepad. If the file you've been working on has not been saved,
you will be prompted to save the file before Notepad exits.

Edit Menu
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The Edit menu contains those functions that allow you to manipulate the information you
have on the screen. In this case, there are four items that appear dim in the menu. The
reason for this is that these items are not available at the present time. In most cases,
you have to have something selected for these items to work. Windows does a pretty
good job of communicating with you to tell you what you can and cannot do. Also notice
that most of the items in the Edit menu have a key combination on the right (Ctrl+Z, etc.).
These are hot keys that can be used from within the document without having to go to
the Edit menu. For example, you can do a Copy from within a document by holding down
the <Ctrl> key and pressing the "C" key. I don't recommend that you try and memorize
these hot keys just now. Instead, I would recommend that you just make note of them as
you use the menu items and over time pick up on those you use most frequently.

Undo - Notepad does have a rather neat feature called the Undo. In essence, this is your
Oops button. If you make a mistake and suddenly say "Oops", you can select the Undo
and reverse whatever it was you just did. Unless I'm mistaken, the Undo item will only
work on the most recent change you've made to your document.

Cut - Again, this item is only available if you have something selected in your document.
Otherwise you have nothing to Cut. You can select some piece of your document by
holding down the left mouse button and dragging across the letters/words/sentences that
you want to select. Your selection will have white letters and a blue background.
Now you will be able to Cut this selection. Cut removes the selected text from your
document and puts it on the Clipboard. The information is not totally deleted, but is being
held in case you want to put it somewhere else.
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Copy - Copy is very similar to Cut. The only difference is that with Copy, your selected
text is not removed from the document. Instead, a copy of your selected text is placed on
the Clipboard for you to use later.

Paste - Once you have some text on the Clipboard (using either Cut or Copy above), you
can move to wherever you would like to put this text and Paste it back into your document.
In other words, the combination of Cut and Paste allows you to move text around within
your document while the combination of Copy and Paste allows you to duplicate
information.

Delete - When you Delete text from your document, it is gone. If you do this by accident,
you can use the Undo function to bring it back, but otherwise it is gone. Delete does not
place the selected text on the Clipboard.

Find... - As you've already seen, this function opens a dialog box that allows you to enter
the text you want to search for along with a couple of pieces of information to help
Notepad perform the search. If the text is found, it will be selected ready for you to Cut,
Copy or overtype.

Find Next - This function simply repeats a previous Find This is useful if you have the
same text in several different places within your document.

Replace - This function allows you to locate some text within your document and replace
it with some other text. It even has the ability to perform its function globally through the
document, but be careful of using this as it can get you into trouble. For example,
suppose you wanted to replace "eat" with "ate" globally throughout a document. This
function would do it, but it would also change "eaten" to "ateen", "cheat" to "chate" and
"defeat" to "defate".
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Go To... - In Goto line, type the line number you want the cursor to jump to. You do not
have to have line numbers in your document for this command to work. Lines are counted
down the left margin beginning at the top of the document.

Select All - If there is something you want to do with all the text in your document at the
same time, all you have to do is select the Select All function and your entire document
will be selected. Now you can either Cut or Copy all the text to your Clipboard.

Time/Date - The Time/Date function is a neat feature of Notepad. Some people like to
keep a journal and in a journal, you might want to have the date and time as part of the
document. Obviously, you can type in the date and time, but with the Time/Date function,
Notepad will automatically insert the date and time like this: 7:47 AM 2/27/98.

Format Menu

Word Wrap - In some cases, you may want the text you type to appear on the same line,
but most of the time, you'd like to be able to see all the text on the screen at the same
time. If you only have a little bit of information, you might be able to enlarge the Notepad
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window to see all the text. Another way of handling this is to select the Word Wrap
function. This will take words that don't fit in the Notepad window and wrap them down to
the next line. A check mark appears when word wrap is turned on. Wrapping text enables
you to see all the text on the line, but it doesn't affect the way text appears when it is
printed.

Font... - This allows you to change the font used to display the file you have open. It
doesn't change the font of the file itself. It simply allows you to view/edit files using
whatever font you wish.

View Menu

This menu only contains one item; Status Bar which will place an extra line at the bottom
of the Notepad window to keep you informed of what has or will be done as you work in
Notepad.

Help Menu



Most programs in Windows have a Help menu that provides information about using that
particular program. The Help menu may not answer all your questions about a program,
but I would encourage you to explore what is there before you look elsewhere. Most
companies marketing software today are providing more Help and less hardcopy
documentation.

Help Topics - Notepad is a very simple program to use as it doesn't contain a lot of bells
and whistles. As a result, the Help Topics is not very long. You should be able to explore
all of Help Topics in just a few minutes. I would encourage you to do so for two reasons.
First, you'll know nearly everything there is to know about Notepad. Second, you'll
become familiar with the format of the Help facility Microsoft uses so you'll know what to
expect in other Microsoft products.



About Notepad - The function of the about for any program is simply to let you know what
version of the program you are running. From time to time, the programmer might include
some additional information about your system, but don't expect this. Here's what my
version of About Notepad looks like:

WEB BROWSER INTERNET EXPLORER
Basic Terms

One of the more popular and fastest growing areas in computing is the Internet.
The Internet is a collection of large computer networks, each of which is a collection of
smaller networks. A network is composed of several computers connected together for
the purpose of sharing information and resources. Consider your computer at Floyd
College. Your computer is connected to the local network at the college, which is in turn
connected to Peachnet, which is connected to the Internet. The software used to connect
computers is called Transmission Control Protocol/Internet Protocol, or TCP/IP.

The World Wide Web

Modern computers have the ability to deliver information in a variety of forms such
as graphics, sound, video, animation, as well as text. The ability to deliver information in
these different forms is called multimedia. On the Internet this multimedia capability is
available in a form called hypermedia. Hypermedia is any variety of computer media
including text, graphics, video and sound. On the Internet, hypermedia is usually
accessed through the use of a hyperlink. A hyperlink, or link, is a special software pointer
that points to the computer that contains the information in whatever format the
information exists. The collection of hyperlinks throughout the Internet creates a network
of links called theWorld Wide Web. Each computer in the Web that contains hypermedia
that can be referenced by hyperlinks and accessed by other computers is called a Web



Site. Hundreds of thousands of Web sites around the world can be accessed through the
World Wide Web.

URL (Uniform Resource Locator)

The URL of a Web page is a unique address of each individual Web page at the
Web sites on the Internet. A typical URL is composed of three parts. We will use the
URL below to explain the function of each part.

The first part of any web address is the protocol. A protocol is a set of rules that
computers follow. Most web pages use http, which stands for hypertext transfer protocol.
HTTP describes the rules for transmitting hypermedia documents electronically. The
protocol is entered in lower case as http and is followed by a colon and two forward
slashes. The colon and the two forward slashes are required punctuation. Other
protocols used on the internet include FTP which stands for file transfer protocol, gopher
which gives the rules for menu driven document transfer, and telnet which describes the
rules for remote terminal sessions.

The second part of a URL is the domain name. The domain name is the Internet
address of the computer on which the Web pages are located. In our example above,
the domain name is www.softbrain.org .The last part of the domain name gives an
indication of the type of organization responsible for the Web site. For example, com at
the end indicates a commercial site, gov indicates a government site, and edu indicates
an educational site.

The third part of theWeb address is the file specification of the web address. This
part of the Web address shows the filename of the web page as well as which folder or
folders contain the Web page. This is called the path name of the page.

HTML (HyperText Markup Language)

Web pages are created using a special formatting language called hypertext
Markup Language. HTML formatting codes are used to display the pictures and graphics
used to create Web pages. When you are viewing a Web page, you can see the HTML
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code used to create the page by selecting the “View” pull-down menu and then clicking
on “Source”.

Home Pages

A home page is the introductory page of a Web site. All other web pages for that
site can usually be reached through the home page.

Internet Browsers

A browser is a program that makes using the World Wide Web easier by removing
the complexity of having to remember the rules, syntax and commands for accessing
Web pages. Internet Explorer is the browser that you will be using in this course. Another
popular browser is Netscape Navigator.

Starting Internet Explorer

Before you can use Internet Explorer, it must be installed on your computer and
you must be connected to the Internet through either a local area network such as the
one at Floyd College or a modem. If the program is installed, you start Internet Explorer
either by double clicking on its icon on the desktop or by clicking on the start button,
Programs, and then Internet Explorer. When the program starts, you should see the
Floyd College home page. The title of the web page will be displayed in the title bar.

The Internet Explorer Window

The Internet Explorer window contains several features to make your work on the
Internet easy. Several of these features are common to all Windows 95 applications such
as the title bar at the top with the menu bar containing pull-down menus below it.

Below the pull-down menus is the standard toolbar. Each of the main features of the
Internet Explorer screen is discussed below:

Menu Bar

The menu bar contains several buttons which are used to group commands into
groups. File contains the commands which relate to file operations such as saving a file
or printing a file. The Edit menu contains commands for editing your work. To display a



menu choice such as File, click on the word File in the menu bar. A list of choices should
appear below the word file. To select one of these menu choices, click on the appropriate
choice from the pull-down menu.

Display area

Most web pages are too large for the entire page to be seen on the computer
screen at one time. When viewing a page in Internet Explorer, you will usually see a
scroll bar at the right side of your screen, which can be used to scroll down and view the
rest of the document. Use the arrows on the top and bottom of the scroll bar to move up
and down through the document.

Some of the words on a web page will be displayed in blue letters. This is the
default color of text which is a hyperlink. A hyperlink is a pointer that sends your computer
to another place on the Internet simply by clicking on the link. Pictures and graphics can
also be hyperlinks. As your mouse pointer is moved over a hyperlink, the pointer changes
to a pointing hand to show you that whatever is displayed on that portion of the screen is
a link (pointer) to another place on the Internet.

Standard Toolbar

The buttons on the standard toolbar allow you to perform common tasks quickly
and more easily than doing those same tasks using the choices on the pull-down menus.
Two very important buttons are back and forward. These buttons allow you to move
through the web pages that you have viewed in Internet Explorer. The back button takes
you back one screen at a time while the forward button moves you forward one screen at
a time. Each button on the toolbar is normally gray. Color is added when the mouse
pointer is placed over a button.

Another important button on the standard toolbar is the STOP button. Some web
pages are very large and take considerable time to load and display. You might see the
first part of a page and decide that you do not need this page or you might decide that
you do not want to wait for the entire page to load. Clicking the STOP button will stop a
web page from being downloaded.

Address Bar



The Address Bar contains a white text box which displays the URL for the web
page currently displayed. The URL of a web page is its Internet address. These will be
discussed in more detail below. You can also type a web address into this box and press
ENTER to load the web page in Internet Explorer.

Internet Explorer Icon

The Internet Explorer Icon rotates while a connection to a web site is being made,
a web page is being loaded into memory, and a web page is being displayed on your
screen.

Status Bar

The Status Bar displays the URL of a link when the mouse pointer passes over the
link. It also provides information about the progress of your request to load a new web
page.

Toolbars

Several toolbars are available in Internet Explorer. Each one contains buttons that
enable you to easily move between web sites and stop a page from being
downloaded.

Internet Addresses

All internet addresses have the same general format as shown below:

http:// www.softbrain.org

The first part, http://, lets the computer know that you are looking for a web server, not
news or mail server. The middle section, www.mcp.com, is the name of the computer
which contains the files you are looking for. The part that appears after the slash names
the folders and filenames of the documents you are looking for. The .html indicates the
type of document you are looking for, in this case HyperText Markup Language which is
the standard language in which all web documents are written.

http://www.mcp.com/que/que.html
http://www.mcp.com/


You can leave off the “http://” when typing an internet address in Internet Explorer.
Internet Explorer also assumes that the address will be in the form www.mcp.com and it
is not necessary to type the www and the com. These will be filled in by internet explorer
if you leave them out while typing an internet address.

Note: Many computers on the internet are case sensitive so you need to make sure that
every letter that should be capitalized is capitalized. Also make sure that you are using
a forward slash “/” when necessary instead of the backslash “\”.

The Links Toolbar

The links toolbar provides a set of links to get the new user oriented to the internet. It
comes with connections to a variety of places including Best of the Web, Microsoft’s

Home Page, the Web Gallery, Product News, and Today’s Links. If you select one of the
links shown on this bar, Explorer opens that Web Page. From there you can access
information in diverse areas by following the links shown on the screen. As an example,
if you choose Best of the Web, you can access information on travel, entertainment,
sports, and much more just by following the links. Travel through the layers and
eventually you will reach an article discussing the subject in which you are interested.

Forward and Back Buttons

Two of the most useful buttons on your screen are shown in the upper left corner of your
screen on the standard toolbar. These are the forward and back buttons. Many times as
you explore on the internet, you will need to move back to a page that you have already
visited. By clicking the back button you can move back through the pages you have
visited one at a time. Then you can click the Forward button to move forward through the
pages as you browse for information.

Note: Once you move back to your first page, the Back button will be gray
indication that you have traveled as far as possible in this direction.

Note: You can only use the forward button after you have first gone back. Until
you go back, the forward button will be gray indicating that this option is
unavailable.

http://www.mcp.com/


Home Button

If you become hopelessly lost in your internet explorations, you can always click the home
button to return to your Starting Page. This page could be out of date especially if it is
one that is updated frequently, so you might need to click on the refresh button to display
the latest version of the page.

Links

The World Wide Web is made of millions of web pages that are joined together by
hypertext links that provide a truly “point and click” environment for accessing information
on your computer. These links are really pointers that instruct your computer where to
go on the Internet to access the information you requested. By default, links are displayed
in blue text, but a web page can display its links in any color. There is one additional way
that you can identify a link. When the mouse pointer is moved over a hypertext link, the
pointer changes to a hand. When the mouse pointer changes to the pointing hand, you
will see the URL of the link displayed in the status bar located at the bottom of your
screen.

Using Links

Links are activated by placing the mouse pointer on the link and clicking once with the
left mouse button. When you click on the link, Internet Explorer loads whatever
document, file, or web page that is attached to that link. While a document is being
loaded, the small globe in the upper left-hand portion of the screen will spin. Explorer will
load the text of a web page before it loads the graphics to allow you to begin reading the
contents of the page while the graphics, which load much slower, are being displayed.
White boxes will be displayed to mark the location of the graphics that will be shown later.
When the globe stops spinning, the page is completely loaded.

Note: If the globe stops spinning half-way through a turn or the message “connecting to
host” is displayed at the bottom of the screen for an extended period of time, then you
have a problem with the web page you are trying to load. Either the site was busy or just
not working for some reason. If this happens, click the “STOP” button located on your
toolbar at the top of the screen.



The Right Mouse Button

Once a web page is displayed, you might want to save the page for later use, or you
might want to use a graphic on the page as wallpaper. To perform either of these tasks,
use the right mouse button. Let’s suppose that you find an image that you want to save
on your hard disk for later use. Point to the image with your mouse and click the “right”
mouse button. A shortcut menu will pop up giving you choices such as saving the image
or using the image as wallpaper. In our example we have found an image that we want
to save on our hard disk, so we will select “Save Picture As” from the shortcut menu that
appears. You will be asked to name the image you are saving and select a location for
saving the file. Click OK when you are finished. You could also select “Set as Wallpaper”
to make the picture the wallpaper that will be displayed on your desktop.

Using History

Internet Explorer provided other ways to move around in the pages you have visited than
just using the Back and Forward buttons. The History List allows you to instantly move
to any site that you have recently visited. History keeps track of not only the sites you
have visited today, but also keeps track of the sites you have visited in the past few
weeks. The exact length of time a site stays in history is determined by the user, but the
default time is two weeks. To use this feature, click on the History button at the top of
your screen and select the site you wish to revisit from the list.

Saving a Web Page

If you are doing research, you are going to need to save the information that you locate
so that you can use it at a later time. Web sites change so often that you cannot be
assured that the files you find on Wednesday will still be there on Thursday. For this
reason, saving files is an extremely important function of computer applications. To save
a web page, follow these steps:

1. With the web page open, click on the file pull-down menu.

2. Select the location where you want to store the file.

3. Give the file an appropriate name.

4. Click the save button in the dialog box.



Note: When you save a web page, all you are saving is the html code. The graphic
that were on the original site will be missing.

Adding Links to the Favorites Menu

When you are searching on the Internet, you will undoubtedly find certain sites that you
will wish to visit often. You can add these sites to a list of "favorite" sites. This is also
called a bookmark. Bookmarks on the internet are just like bookmarks in a book. The
mark your place.

To add a web page to your list of favorites, follow these steps:

1. While viewing the page you wish to bookmark, click on the "favorites"
pulldown menu.

2. Select "Add to Favorites".
3. In the name box, type the name that you wish Internet Explorer to use in

your list of favorites.

4. Click OK and this site will be added to your list of favorites.

Accessing the Favorites Menu

To view a page that you have listed as a favorite, simply click on the "Favorites" button
on the standard toolbar and select the web page that you wish to go to.



WEB FRAMEWORK DREAMWEAVER
Dreamweaver is a web authoring program that uses a WYSIWYG “what you see is what

you get” interface. The HTML code is being created and is accessible to you if you want

to play with it.

Finally, let’s get started with Dreamweaver.

Launch Dreamweaver

1. Start Dreamweaver. You should see a startup screen.3

Dreamweaver lets you publish your Web site by easily uploading your Web site to a

Web server. Right now we won’t be worrying about that. For now, you will be creating

and viewing your site locally (which means the site will be located on your computer).

We need to define your site:

Create a New Site

2. From the Site menu, choose Manage Sites… The Manage Sites Box should appear.

3. Click New and then choose Site from the pop-up menu.

4. Click on the Advanced Tab under Site Definition for Unnamed Site 1.

Local Info

Local Info is where we put in the information about the files that are on your local computer
(which is where all your files are or will be for now).

5. In the Advanced Tab, under Category, choose Local Info. 4



6. Next to Site Name, type: My First Dreamweaver Web site. You will use this name
when you go into Dreamweaver to retrieve the files associated with this site. This
name has to be unique within Dreamweaver.

7. Next to Local root folder, click on the yellow folder icon to browse for where you want
to store your web site on your local computer. You may wish to create a new folder
to sore your files in. I stored my Web site on F: (my flash drive) in a folder I called My
Website. This is now your Root Folder

8. Click DONE. You should see a Files panel on the right side of your screen. The Local
View in the Files Panel will display all the files for your Web site that are in the Root
Folder on your computer. Later we will add information about connecting to the
server.

The Remote View shows which files have been uploaded to the server.

9. Once we’ve entered all this information about local and remote servers, it will be set
up for us next time we use Dreamweaver on this computer. Unfortunately, it doesn’t
work that way on lab computers. If you move to another computer, you will have to
set up your Web site on the new computer as well. 5

WHAT’S A ROOT FOLDER?

The local root folder is where you will keep ALL the files for your web site. You can create
subfolders under it, but consider it to be the parent of all parent folders. You’ll keep all of
the files and subfolders for your Web site (including html pages, images, multimedia files,
etc.) either in the root folder or a subfolder under the root folder.

Making your first Web Page:

10. Under the File menu at the top, choose New.

11. In the New Document dialog box, make sure you have Blank Page selected, the Page
Type is HTML, and the Layout is <none>.



12. Click Create. You should now see a blank Web page in the Document Window.

13. Under the File Menu, choose Save.

14. In the Save As box, find your Web site folder and save your file as index.html

15. Click Save. In the Files panel, you should now see index.html. Congratulations!

You’ve created your first Web page using Dreamweaver. Unfortunately, it’s pretty boring

at the moment.
Save the Page

RULES OF THUMB for naming web files:

• Do not use spaces or special characters, such as those found about the number keys
on the keyboard, in your file names. You can use dashes and underscores. (e.g.,
my_page.html)

• Always use a 3- or 4-character file extension for every file you use on the Web. In the
case of a regular Web page, always use .html or .html.

• Be very specific about capitalizing because most Web servers are case-sensitive.

Give your Web Page a Title In the document toolbar, find the Title box.

16. On the document toolbar, locate the Title field. 6

17. Type in a title for your page. Feel free to be creative (but not indecent). Hit Enter.

18. The title doesn’t show up on the page, but will appear in tabs and across the top of
browsers. Adding Some Content Add Content to the Page

19. In the Document window, type in a good title. This one will be the head of your Web
page. If you can’t think of anything, you can always use, “Aardvark Adoption Society
of Delaware”.



20. Add a subtitle. Again, it can be anything you want. If you’d prefer, it could be, “We
speak for

Aardvarks who can’t speak for themselves.”

21. Now that you’ve got a good title, add some content. Logically, it should go with the
title. Type one or two lines now for now. We’ll add more later. (If you can’t think of
anything, feel free to throw in some of the Aardvark content).

Now let’s format the content:

22. On the Web page, highlight the title.

23. In the Property Inspector, click on the Format drop down arrow, and choose Heading
1.

Note: If you do not see the Property Inspector, choose Window >> Properties.

24. On the web page, highlight the second line of text.

25. From the Format menu on the Property Inspector, choose Heading 2.

Note: When formatting your text, keep in mind that text sizes in HTML are relative sizes.
This means that, when your page is viewed in a browser, the text size will depend on the
default text size settings on each user’s computer. Relative sizes give users the ability to
adjust the text size to suit their individual needs.

This option is especially important for people with visual impairments, but it means that
the appearance of your pages may vary from computer to computer. Playing with Font
Properties

26. Highlight the Subtitle. Change the font size to 24. 7

27. Highlight any word on the page and click the Bold icon ( ) on the Property Inspector.
The selected word appears bold.



28. Highlight the title click the gray square to the right of the Size popup menu in the
Property Inspector. A grid of colored squares appears, and the cursor changes to an
eye dropper.

29. Click the eyedropper on the desired color. The field to the right of the color swatch
reflects the code Web browsers need to correctly display the color you’ve chosen.

30. Click anywhere on the page to deselect the text. The previously selected text appears
in the new color.

Alignment

31. 1. Highlight the title and subtitle on the page.

32. Click the Align Center button ( ) on the Property Inspector. The titles should now be
centered on your page.

Creating Lists

33. First we need to add a list. 8
34. Type in a title for your list and then type in a list of items. Make sure there are at least

3 items in your list. Make sure you hit return after each item. (Feel free to use a list
from the aardvark homework if you can’t think of your own.)

35. Highlight the list title and choose Heading 3 from the Format menu on the Property
Inspector.

36. Highlight the list items and click the Unordered List button on the Property Inspector.

37. The items appear as a bulleted list.

38. Now type in another List title and another list of items.

39. Highlight the title and select Heading 3.



40. Highlight the rest of the items and click the Ordered List button on the Property
inspector (next to the ordered list button). The items should now appear in a
numbered list.

41. Save your work. Get into the habit of saving your work regularly.

Page Properties

In this section you will learn how to set your page’s background color, as well as the
default text and link colors. These settings differ from what you’ve done so far on the

Property Inspector because they’ll apply to all the text and links on the page—not just a
selected piece of text.

42. From the Modify menu at the top of the workspace, choose Page Properties.

43. To change the text color, click the bottom right corner of the text color box.

44. Using the eyedropper, choose a color by clicking on any of the color swatches.

45. Similarly, you can change the background color for the page using the Background
color setting. 9

46. You can also change the color of links, active links, and visited links. An active link is
a link just when the user clicks it. A color change lets the user know that s/he clicked
on a link. A visited link is one that the user has already clicked on and visited. A color
change lets the user knows /he’s already visited that link.

47. Select “Links” from the Category menu at left, then make your selections for link,
visited link, and active link colors as you did in Step 3.

48. Click the Apply button to see how your color choices look on the index page. The
Page Properties dialog box will remain on the screen.

49. When you’re satisfied with the colors you’ve picked, click OK.



Note: You can add a background image if you want. Browse to find an image by the
background image.

See what it looks like. Now you know that’s an option. We’ll talk about this option more
later. For now, go back to a solid color background.

Note: If you changed the color for any text using the Property Inspector, those changes
will override general page color choices.

Web Page Preview

As you create a page in Dreamweaver, the page may not look exactly like it would in a
browser. To preview the page in a browser:

50. Choose File >> Preview in Browser >> i.e. explorer or Netscape or press the F12 key.
A web browser, such as Netscape or Internet Explorer, opens and loads the web
page.

51. Take a look at your page to see how it will appear on the Web.

52. When finished, close the browser and switch back to Dreamweaver.

NOTE: Colored or underlined text can be mistaken for links. Choose your color scheme
so that the links stand out from rest of the text. The text and links also should stand out
from the background for readability. When selecting colors, keep it simple. Too many
colors can be distracting or confusing.
Adding Images

Note: Any editing or resizing of an image should be completed before it is added to a web
page.

53. First you need an image. Feel free to find one on your own that suits the theme of
your web page. If you don’t feel like it, I’ve included an image on my Web site that
you can download.



54. Next, add it to your Web page.

55. Place your cursor below the sub-header in your document and press Enter twice.

56. 2. Choose Insert >> Image. The Select Image Source dialog box will appear.

57. 3. Using the dialog box, locate and select an image, then click OK. 10

58. 4. You will first encounter a prompt to add accessibility attributes:

59. Type a brief description of the image in the Alternate text box, and then click OK.

60. Because you’re trying to use a file that lies outside your root folder (my website), you’ll
receive the following message:

61. Click Yes. The Copy File As dialog box will appear.

62. Click the Save button to place a copy of the image file inside your my website folder.

63. The image will appear on your web page.

64. Click the Refresh button on the Files panel ( ) and the image file will appear in the list
of local files.

Delete an Image

65. In the Document window, click on the image to select the image.

66. Press the Delete key. The image disappears.

67. To reverse the deletion, use the Undo command. From the Edit menu, choose Undo.
The image should re-appear on the page.

Create a Second Page

Next, you will create a second page for your Web site.

68. From the File menu, choose New…The New page dialog box appears.



69. Click the Create button. The new file will appear in the document window.

70. Save your new page in the my website folder as Page2.html

71. In the Title field, type an appropriate title for this page. We’ll eventually make it into a
Calendar of Events Page, if that helps you decide on a title.

72. Save your work.

Page Planning: When planning your Web site, you will need to decide how to organize
eachWeb page. What will be placed on each page? Divide your site into pages for simple
access. If your readers want to read or print only a calendar of

events, you don’t want them to have to print the entire site to see it. Your site planning
will also include how the pages will be linked together.

Page Navigation

Now that we have two pages, you can link them together. We’ll link the index.html page
to the Page2.html and vice versa. It’s easy in Dreamweaver!

73. Use the tabs on the Document toolbar to toggle back to the index page.

74. On the index page, type some descriptive text that describes your Page2.html.

75. Highlight the text you want to make a link.

76. In the Property Inspector, click on the Browse for File icon to the right of the link box.

A Select File dialog box appears. 12

77. Using the dialog box locate and select the file Page2.html.

78. Click the OK button. Cool! You just made a link!
79. The selected linked text is underlined and appears in the link color you chose. In the

Property Inspector, the Link field reads: “Page2.html



80. Save your work and preview the page in a browser.

81. Test the link. When finished, return to Dreamweaver.

82. Now, try linking Page2.html back to the index page.

83. Save your work and test the new link in a browser.

Note: The text you use for your link should be brief but descriptive, giving your visitors an
idea of where the link will take them even before they click it.

Let’s compare: click here for more information lacks detail.

Compared to Calendar of Upcoming Events, which is clear and concise?

84. Link to a Web Page

85. Next let’s add an external link. By that I mean let’s link to a Web page that is located

somewhere on the World Wide Web. We’ll need to use the full (absolute) URL to

link to this page.

86. Go to the bottom of your index.html page and type “More info on Aardvarks”.

87. Highlight the text you just typed.

88. In the Link box in the Property Inspector, type http://en.wikipedia.org/wiki/Aardvark/
and press Enter.

89. The text you selected should now link to Wikipedia’s web page on Aardvarks. To
make sure the link works properly, preview the page in a browser.

90. Switch back to Dreamweaver to continue editing your page.

Add an E-mail Link

http://en.wikipedia.org/wiki/Aardvark/


Now you’ll make your e-mail address a link so that visitors can send you questions and
comments via email.
91. At the bottom of your page, type “Send me an email” and highlight the word email.

92. From the Insert toolbar (across the top, below File Edit, etc.), click on the envelope
icon to insert an email link.

93. Place your cursor in the E-mail box and type your email address:

94. Hit OK. Your e-mail address appears as a link.

95. Save your work. Please note that the email link will try to open a desktop email
program if you have one on your computer. However, if the computer you’re working
on doesn’t have an email program set up, testing this link won’t work.

Note: One of the advantages in creating a course Web site is adding appropriate links to
other sites on the Web. You may want to compile a list of links that support your
instructional goals. This allows you to supplement your page with appropriate Web
resources. Plus it’s always fun to look around at other relevant pages to learn new things
about your topic and create your own relevant Webliography.

Creating a Link within a Page

Create the Target of the link

96. Place your cursor at the top of your page

97. Choose Insert >> Named Anchor. The Named Anchor dialog box will appear.

98. In the Anchor Name box, type a name for the anchor. This should describe the
content in that section of the page.



99. Click OK. A yellow anchor will appear just before the text. If the yellow anchor symbol
does not appear, then choose View >> Visual Aids >> Invisible Elements.

Create a link to the anchor
100. At the bottom of the page, type “Back to Top”. Highlight this text.

101. On the Property Inspector, click on the point-to-file icon to the right of the Link field
and drag it to the schedule anchor symbol. (You literally click on it and, without
releasing the mouse, drag it over the anchor symbol in your Web page).

As the arrowhead moves over the anchor, the anchor name preceded by the pound sign
(#) will appear in the link field. The selected text is now a link, and is underlined with a
different text color.

The form that this type of link uses is different from a standard link. In the link field, a
pound sign appears followed by the name of the anchor. The # (pound sign) indicates
that the link is to an anchoron the Web page.

Note: When planning your Web site, you will need to decide how to organize links
between all the pages.

A good practice is to place links to other pages at the top and the bottom of each page.

Also, each page should be linked to your home page (index.html).

Page Layout with Tables

We can use Tables to lay out the format of text and images. A table has rows and columns
and may be used for layout in a number of ways, including placing text or images side by
side on a page. In this section, you’ll make a table that shows the Calendar dates and
events for an Aardvark Sanctuary.

Create a Table

102. Place your cursor at the top of Page2.html after the text. Now, you’ll insert a table
with 3 rows and 2 columns.

103. From the Insert menu, choose Table. The Table dialog box appears.



104. Under Table size, adjust the settings as follows:

Rows = 3

Columns = 2
Table width = 75 %

Border thickness = 1 15

105. Click OK. The table will appear on your page.

106. Place your cursor in the upper-left cell of the table and type: “Schedule of Events”

107. On the second row, in the left-hand cell type: Date

108. Press the [Tab] key to move to the next cell in the table.

109. Type: Event

110. Press the [Tab] key again to move to the next row.

111. Type in a date. Move to the next cell, and type in a description of an event. As you
type in a long paragraph, the words wrap within a cell.

112. Press the TAB key, and a new row is automatically added to the table. Enter the
date and event description in the fourth row.

Merge Cells

We want the Schedule of Events to be centered across the entire table. To do that, we
first need to merge the two top cells in the table.

113. Click and drag your cursor from left to right across row 1. You’ll now merge those
two cells into one.

114. Choose Modify >> Table >> Merge Cells. Now, in row 1, you should see one large
cell.



Insert an Image

115. Place your cursor in the right-hand cell of the last row. Press the [Tab] key to add a
new row.

116. Place your cursor in the right-hand cell of that new row. Choose Insert >> Image.

The Select Image Source dialog box appears.
117. Navigate to an image – either one you’ve downloaded and is on your flash drive or

one from my Web site that you can download.

118. Click OK. The image you chose will appear in the table cell.

Add a new row to the table.

After you have created a table, you may need to add information in the middle of the
table. You can add rows or columns to expand the table.

119. Click in the third row of your table.

120. Choose Modify >> Table >> Insert Row.

A new row appears in the table.

121. Click in the second column of the new row and insert another image (your choice).

The image appears in the cell.

122. Click in the cell to the left of the image and type some relevant information in the
cell.

Delete a row

The table can also be adjusted by removing unnecessary rows or columns.

123. Click in the second row of your table.

124. From the Modify menu, choose Table, and then choose Delete Row. The row and
its contents are deleted. Table

Resize columns and rows

Depending on the content you add to your table you might find that columns are too wide
or narrow.



You can adjust the column width to better fit the content in your table.

125. Place the cursor over the line dividing the columns. The cursor turns into a
twoheaded arrow.

126. Click and drag the two-headed arrow toward the right to the middle of the table. The
columns are re-sized.

127. Place the cursor over the right side of the table. Click and drag the two-headed arrow
to resize the table again.

128. Save and preview the page.
Try changing the size of the browser window. Notice that the table size changes as the
browser window size changes – why? The reason the table size is not constant is
because the width of the table is expressed as a percentage of the total width of the
browser window, in this case, 75%. If you wish to lock the table to a specific size, you
have to express the table dimensions differently.

Table dimensions can also be expressed as fixed using “pixels”. A pixel is a single point
in a graphic image. Screens are divided into thousands (or millions) of pixels, arranged
in rows and columns. On a 17 Web page, a recommended pixel size for a table’s width
would be no higher than 600. (Assuming a screen resolution of 800 x 600).

When your table is selected, you can view and change the table width on the Property
Inspector.

Experiment with cell color and other options

129. To add background shading to a cell or row, select the cell(s) and click on the bottom
corner of the Bgcolor box on the Property Inspector

130. Click on a swatch with the eyedropper to choose a color.

131. Try various formatting options for the rest of the table using the Property Inspector.
Change the size, color or style of the text, and try the alignment options.

132. Save your work and preview.
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